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Cisco Transport Controller Operation
This chapter describes Cisco Transport Controller (CTC), the Cisco software interface for the Cisco
ONS 15454 SDH. For CTC set up and login information, refer to the Cisco ONS 15454 SDH Procedure
Guide.
Chapter topics include:
•

8.1 CTC Software Delivery Methods, page 8-1

•

8.2 CTC Installation Overview, page 8-4

•

8.3 PC and UNIX Workstation Requirements, page 8-4

•

8.4 ONS 15454 SDH Connection, page 8-6

•

8.5 CTC Window, page 8-7

•

8.6 TCC2/TCC2P Card Reset, page 8-17

•

8.7 TCC2/TCC2P Card Database, page 8-17

•

8.8 Software Revert, page 8-17

8.1 CTC Software Delivery Methods
ONS 15454 SDH provisioning and administration is performed using the CTC software. CTC is a Java
application that is installed in two locations; CTC is stored on the Advanced Timing, Communications,
and Control (TCC2) card or the Advanced Timing, Communications, and Control Plus (TCC2P) card,
and it is downloaded to your workstation the first time you log into the ONS 15454 SDH with a new
software release.

8.1.1 CTC Software Installed on the TCC2/TCC2P Card
CTC software is preloaded on the ONS 15454 SDH TCC2/TCC2P card; therefore, you do not need to
install software on the TCC2/TCC2P cards. When a new CTC software version is released, use the
release-specific software upgrade guide to upgrade the ONS 15454 SDH software on the TCC2/TCC2P
cards.
When you upgrade CTC software, the TCC2/TCC2P cards store the new CTC version as the protect CTC
version. When you activate the new CTC software, the TCC2/TCC2P cards store the older CTC version
as the protect CTC version, and the newer CTC release becomes the working version. You can view the
software versions that are installed on an ONS 15454 SDH by selecting the Maintenance > Software tabs
in node view (Figure 8-1).
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Figure 8-1

CTC Software Versions, Node View

Select the Maintenance > Software tabs in network view to display the software versions installed on all
the network nodes (Figure 8-2).
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Figure 8-2

CTC Software Versions, Network View

8.1.2 CTC Software Installed on the PC or UNIX Workstation
CTC software is downloaded from the TCC2/TCC2P cards and installed on your computer automatically
after you connect to the ONS 15454 SDH with a new software release for the first time. Downloading
the CTC software files automatically ensures that your computer is running the same CTC software
version as the TCC2/TCC2P cards you are accessing. The computer CTC software files are stored in the
temporary directory designated by your computer’s operating system. You can use the Delete CTC
Cache button to remove files stored in the temporary directory. If the files are deleted, they download
the next time you connect to an ONS 15454 SDH. Downloading the Java archive files, called “JAR” files,
for CTC takes several minutes depending on the bandwidth of the connection between your workstation
and the ONS 15454 SDH. For example, JAR files downloaded from a modem or a data communication
channel (DCC) network link require more time than JAR files downloaded over a LAN connection.
During network topology discovery, CTC polls each node in the network to determine which one
contains the most recent version of the CTC software. If CTC discovers a node in the network that has
a more recent version of the CTC software than the version you are currently running, CTC generates a
message stating that a later version of the CTC has been found in the network and offers to install the
CTC software upgrade. If you have network discovery disabled, CTC will not seek more recent versions
of the software. Unreachable nodes are not included in the upgrade discovery.

Note

Upgrading the CTC software will overwrite your existing software. You must restart CTC after the
upgrade is complete.
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8.2 CTC Installation Overview
To connect to an ONS 15454 SDH using CTC, you enter the ONS 15454 SDH IP address in the URL
field of Netscape Communicator or Microsoft Internet Explorer. After connecting to an
ONS 15454 SDH, the following occurs automatically:
1.

A CTC launcher applet is downloaded from the TCC2/TCC2P card to your computer.

2.

The launcher determines whether your computer has a CTC release matching the release on the
ONS 15454 SDH TCC2/TCC2P card.

3.

If the computer does not have CTC installed, or if the installed release is older than the
TCC2/TCC2P card’s version, the launcher downloads the CTC program files from the TCC2/TCC2P
card.

4.

The launcher starts CTC. The CTC session is separate from the web browser session, so the web
browser is no longer needed. Always log into nodes having the latest software release. If you log
into an ONS 15454 SDH that is connected to ONS 15454 SDHs with older versions of CTC, CTC
files are downloaded automatically to enable you to interact with those nodes. The CTC file
download occurs only when necessary, such as during your first login. You cannot interact with
nodes on the network that have a software version later than the node that you used to launch CTC.

Each ONS 15454 SDH can handle up to five concurrent CTC sessions. CTC performance can vary,
depending upon the volume of activity in each session, network bandwidth, and TCC2/TCC2P card load.

8.3 PC and UNIX Workstation Requirements
To use CTC in the ONS 15454 SDH, your computer must have a web browser with the correct Java
Runtime Environment (JRE) installed. The correct JRE for each CTC software release is included on the
ONS 15454 SDH software CD. If you are running multiple CTC software releases on a network, the JRE
installed on the computer must be compatible with the different software releases.
Table 8-1 shows JRE compatibility with ONS software releases.
Table 8-1

JRE Compatibility

ONS Software Release

JRE 1.2.2
Compatible

JRE 1.3
Compatible

JRE 1.4
Compatible

JRE 5.0
Compatible

ONS 15454 SDH Release 3.3

Yes

Yes

No

No

No

Yes

No

No

No

Yes

No

No

ONS 15454 SDH Release 4.1

No

Yes

No

No

ONS 15454 SDH Release 4.5

No

Yes

No

No

ONS 15454 SDH Release 4.6

No

Yes

Yes

No

ONS 15454 SDH Release 4.7

No

Yes

Yes

No

ONS 15454 SDH Release 5.0

No

No

Yes

No

ONS 15454 SDH Release 6.0

No

No

Yes

No

ONS 15454 SDH Release 7.0

No

No

Yes

Yes

ONS 15454 SDH Release 3.4
ONS 15454 SDH Release 4.0

1

1. Software releases 4.0 and later notify you if an older version of the JRE is running on your PC or UNIX
workstation.
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Note

To avoid network performance issues, Cisco recommends managing a maximum of 50 nodes
concurrently with CTC. The 50 nodes can be on a single DCC or split across multiple DCCs. Cisco does
not recommend running multiple CTC sessions when managing two or more large networks.
To manage more than 50 nodes, Cisco recommends using Cisco Transport Manager (CTM). If you do
use CTC to manage more than 50 nodes, you can improve performance by adjusting the heap size; see
the “General Troubleshooting” chapter of the Cisco ONS 15454 SDH Troubleshooting Guide. You can
also create login node groups; see the “Connect the PC and Log Into the GUI” chapter of the
Cisco ONS 15454 SDH Procedure Guide.
Table 8-2 lists the requirements for PCs and UNIX workstations. In addition to the JRE, the Java plug-in
is also included on the ONS 15454 SDH software CD.
Table 8-2

CTC Computer Requirements

Area

Requirements

Notes

Processor
(PC only)

Pentium 4 processor or equivalent

A faster CPU is recommended if your
workstation runs multiple
applications or if CTC manages a
network with a large number of nodes
and circuits.

RAM

512 MB or more

A minimum of 1 GB is recommended
if your workstation runs multiple
applications or if CTC manages a
network with a large number of nodes
and circuits.

Hard drive

20 GB hard drive with 50 MB of space
available

CTC application files are
downloaded from the TCC2/TCC2P
to your computer’s Temp directory.
These files occupy 5 to 10 MB of
hard drive space.

Operating
system

•

PC: Windows 98, Windows NT 4.0,
Windows 2000, or Windows XP

•

Workstation: Ultra 10 Sun running
SunOS 6, 7, or 8

—
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Table 8-2

CTC Computer Requirements (continued)

Area

Requirements

Java Runtime JRE 1.4.2 or JRE 5.0
Environment

Notes
JRE 1.4.2 is installed by the CTC
Installation Wizard included on the
Cisco ONS 15454 software CD.
JRE 1.4.2 and JRE 5.0 provide
enhancements to CTC performance,
especially for large networks with
numerous circuits.
Cisco recommends that you use
JRE 1.4.2 or JRE 5.0 for networks
with Software R7.0 nodes. If CTC
must be launched directly from nodes
running software R5.0, or R6.0,
Cisco recommends JRE 1.4.2.If CTC
must be launched directly from nodes
running software earlier than R5.0,
Cisco recommends JRE 1.3.1_02.

Web browser

PC:Internet Explorer 6.x or Netscape 7.x

For the PC, use JRE 1.4.2 or JRE 5.0
with any supported web browser.
• UNIX Workstation: Mozilla 1.7, Netscape
Cisco recommends Internet Explorer
4.76, Netscape 7.x
6.x. For UNIX, use JRE 5.0 with
Netscape 7.x or JRE 1.3.1_02 with
Netscape 4.76.
•

Netscape 4.76 or 7.x is available at
the following site:
http://channels.netscape.com/ns/bro
wsers/default.jsp
Internet Explorer 6.x is available at
the following site:
http://www.microsoft.com
Cable

User-supplied Category 5 straight-through
cable with RJ-45 connectors on each end to
connect the computer directly to the ONS
15454 SDH or through a LAN

—

8.4 ONS 15454 SDH Connection
You can connect to the ONS 15454 SDH in multiple ways. You can connect your PC directly the
ONS 15454 SDH (local craft connection) using the RJ-45 port on the TCC2/TCC2P card, to the LAN
pins on the MIC-C/T/P, or by connecting your PC to a hub or switch that is connected to the ONS 15454
SDH. You can connect to the ONS 15454 SDH through a LAN or modem, and you can establish TL1
connections from a PC or TL1 terminal. Table 8-3 lists the ONS 15454 SDH connection methods and
requirements.
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Table 8-3

Method

ONS 15454 SDH Connection Methods

Description

Requirements

Local craft Refers to onsite network connections
between the CTC computer and the
ONS 15454 SDH using one of the following:

Corporate
LAN

•

The RJ-45 (LAN) port on the
TCC2/TCC2P card

•

The LAN pins on the ONS 15454 SDH
MIC-C/T/P FMEC

•

A hub or switch to which the
ONS 15454 SDH is connected

Refers to a connection to the
ONS 15454 SDH through a corporate or
network operations center (NOC) LAN.

•

If you do not use Dynamic Host
Configuration Protocol (DHCP), you
must change the computer IP address,
subnet mask, and default router, or use
automatic host detection.

•

The ONS 15454 SDH must be
provisioned for LAN connectivity,
including IP address, subnet mask,
default gateway.

•

The ONS 15454 SDH must be
physically connected to the corporate
LAN.

•

The CTC computer must be connected
to the corporate LAN that has
connectivity to the ONS 15454 SDH.

TL1

—
Refers to a connection to the
ONS 15454 SDH using TL1 rather than
CTC. TL1 sessions can be started from CTC,
or you can use a TL1 terminal. The physical
connection can be a craft connection,
corporate LAN, or a TL1 terminal. Refer to
the Cisco ONS 15454 SDH TL1 Reference
Manual for more information about TL1.

Remote

Refers to a connection made to the
ONS 15454 SDH using a modem.

•

A modem must be connected to the
ONS 15454 SDH.

•

The modem must be provisioned for
ONS 15454 SDH. To run CTC, the
modem must be provisioned for
Ethernet access.

8.5 CTC Window
The CTC window appears after you log into an ONS 15454 SDH (Figure 8-3). The window includes a
menu bar, toolbar, and a top and bottom pane. The top pane provides status information about the
selected objects and a graphic of the current view. The bottom pane provides tabs and subtabs to view
ONS 15454 SDH information and perform ONS 15454 SDH provisioning and maintenance. From this
window you can display three ONS 15454 SDH views: network, node, and card.
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Figure 8-3

Node View (Default Login View)

Lower card shelf
Node view

Upper FMEC shelf

Menu
Tool bar

Status area
Graphic area

Tabs

102028

Subtabs

Status bar

8.5.1 Node View
Node view, shown in Figure 8-3, is the first view open after you log into an ONS 15454 SDH. The login
node is the first node shown, and it is the “home view” for the session. Node view allows you to view
and manage one ONS 15454 SDH node. The status area shows the node name; IP address; session boot
date and time; number of Critical (CR), Major (MJ), and Minor (MN) alarms; the name of the current
logged-in user; and the security level of the user; software version; and the network element default
setup.

8.5.1.1 CTC Card Colors
The graphic area of the CTC window depicts the ONS 15454 SDH shelf assembly. The colors of the
cards in the graphic reflect the real-time status of the physical card and slot (Table 8-4).
Table 8-4

Node View Card Colors

Card Color

Status

Gray

Slot is not provisioned; no card is installed.

Violet

Slot is provisioned; no card is installed.

White

Slot is provisioned; a functioning card is installed.

Yellow

Slot is provisioned; a Minor alarm condition exists.
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Table 8-4

Node View Card Colors (continued)

Card Color

Status

Orange

Slot is provisioned; a Major alarm condition exists.

Red

Slot is provisioned; a Critical alarm exists.

The colors of the Front Mount Electrical Connection (FMEC) cards reflect the real-time status of the
physical FMEC cards. Table 8-5 lists the FMEC card colors. The FMEC ports shown in CTC do not
change color.

Note

You cannot preprovision FMECs.
Table 8-5

Node View FMEC Color

Upper Shelf FMEC Color

Status

White

Functioning card is installed.

Yellow

Minor alarm condition exists.

Orange (Amber)

Major alarm condition exists.

Red

Critical alarm exists.

Port color in both card and node view indicates the port service state. Table 8-6 lists the port colors and
their service states. For more information about port service states, see Appendix B, “Administrative and
Service States.”
Table 8-6

Node View Card Port Colors and Service States

Port Color

Service State

Description

Blue

Locked-enabled,loopback

Port is in a loopback state. On the card in node view, a
line between ports indicates that the port is in terminal or
facility loopback (see Figure 8-4 on page 8-10 and
Figure 8-5 on page 8-10). Traffic is carried and alarm
reporting is suppressed. Raised fault conditions, whether
or not their alarms are reported, can be retrieved on the
CTC Conditions tab or by using the TL1 RTRV-COND
command.

Blue

Locked-enabled,
maintenance

Port is out-of-service for maintenance. Traffic is carried
and loopbacks are allowed. Alarm reporting is
suppressed. Raised fault conditions, whether or not their
alarms are reported, can be retrieved on the CTC
Conditions tab or by using the TL1 RTRV-COND
command. Use Locked-enabled,maintenance for testing
or to suppress alarms temporarily. Change the state to
Unlocked-enabled; Locked-enabled,disabled; or
Unlocked-disabled,automaticInService when testing is
complete.

Gray

Locked-enabled,disabled

The port is out-of-service and unable to carry traffic.
Loopbacks are not allowed in this service state.
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Table 8-6

Node View Card Port Colors and Service States (continued)

Port Color

Service State

Description

Green

Unlocked-enabled

The port is fully operational and performing as
provisioned. The port transmits a signal and displays
alarms; loopbacks are not allowed.

Violet

Unlocked-disabled,
automaticInService

The port is out-of-service, but traffic is carried. Alarm
reporting is suppressed. The node monitors the ports for
an error-free signal. After an error-free signal is detected,
the port stays in this state for the duration of the soak
period. After the soak period ends, the port service state
changes to Unlocked-enabled.
Raised fault conditions, whether or not their alarms are
reported, can be retrieved on the CTC Conditions tab or
by using the TL1 RTRV-COND command. The AINS
port will automatically transition to Unlocked-enabled
when a signal is received for the length of time
provisioned in the soak field.

Figure 8-4

Terminal Loopback Indicator

Figure 8-5

Facility Loopback Indicator

8.5.1.2 Card and Port States
The wording on a lower-shelf card in node view shows the status of a card (Active, Standby, Loading,
or Not Provisioned). Table 8-7 lists the card states.
Table 8-7

Node View Card States

Lower Shelf Card Status Description
Sty

Card is in standby.

Act

Card is active.

NP

Card is not present.

Ldg

Card is resetting.
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The graphics on a port in node view show the state of a port (diagonal lines or loop graphics). Table 8-8
lists the port graphic and their description.
Table 8-8

Node View Port Graphics

Lower Shelf Port Graphics

Description

Multiple diagonal lines on
port

Port is in service and card was reset.

Loop graphic on port

Port is in service and has a loopback provisioned in Card View >
Maintenance > Loopback tabs.

8.5.1.3 Node View Card Shortcuts
If you move your mouse over cards in the graphic, popups display additional information about the card
including the card type; the card status (active or standby); the type of alarm, such as Critical, Major,
and Minor (if any); and the alarm profile used by the card. Right-click a card to reveal a shortcut menu,
which you can use to open, reset, or delete a card. Right-click a slot to preprovision a card (that is,
provision a slot before installing the card).

8.5.1.4 Node View Tabs
Table 8-9 lists the tabs and subtabs available in the node view.
Table 8-9

Node View Tabs and Subtabs

Tab

Description

Subtabs

Alarms

Lists current alarms (CR, MJ, MN) for the
node and updates them in real time.

—

Conditions

Displays a list of standing conditions on the
node.

—

History

Provides a history of node alarms including
date, type, and severity of each alarm. The
Session subtab displays alarms and events for
the current session. The Node subtab displays
alarms and events retrieved from a fixed-size
log on the node.

Session, Node

Circuits

Creates, deletes, edits, and maps circuits.

—

Provisioning

Provisions the ONS 15454 SDH node.

General, Ether Bridge, Network,
OSI, MS-SPRing, Protection,
Security, SNMP, Comm Channels,
Timing, Alarm Profiles,
Cross-Connect, Defaults,
WDM-ANS
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Table 8-9

Node View Tabs and Subtabs (continued)

Tab

Description

Inventory

Provides inventory information (part number, —
serial number, CLEI codes) for cards installed
in the node. Allows you to delete and reset
cards.

Maintenance

Performs maintenance tasks for the node.

Subtabs

Database, Ether Bridge, OSI,
MS-SPRing, Software,
Cross-Connect, Overhead XConnect,
Protection, Diagnostic, Timing,
Audit, RIP Routing Table, Routing
Table, Test Access, DWDM

8.5.2 Network View
Network view allows you to view and manage ONS 15454 SDHs that have DCC connections to the node
that you logged into and any login node groups you selected (Figure 8-6).
Figure 8-6

CTC Network View

Dots indicate
selected node

102027

Bold letters indicate
login node, asterisk
Icon color indicates
indicates topology host
node status

Note

Nodes with DCC connections to the login node do not appear if you checked the Disable Network
Discovery check box in the Login dialog box.
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The graphic area displays a background image with colored ONS 15454 SDH icons. A Superuser can set
up the logical network view feature, which enables each user to see the same network view. Selecting a
node or span in the graphic area displays information about the node and span in the status area.

8.5.2.1 CTC Node Colors
The color of a node in network view, shown in Table 8-10, indicates the node alarm status.
Table 8-10

Node Status Shown in Network View

Color

Alarm Status

Green

No alarms

Yellow

Minor alarms

Orange

Major alarms

Red

Critical alarms

Gray with Unknown#

Node initializing for the first time (CTC displays Unknown#
because CTC has not discovered the name of the node yet)

8.5.2.2 Network View Tabs
Table 8-11 lists the tabs and subtabs available in network view.
Table 8-11

Network View Tabs and Subtabs

Tab

Description

Subtabs

Alarms

Lists current alarms (CR, MJ, MN) for the
network and updates them in real time.

—

Conditions

Displays a list of standing conditions on the
network.

—

History

Provides a history of network alarms including —
date, type, and severity of each alarm.

Circuits

Creates, deletes, edits, filters, and searches for —
network circuits.

Provisioning

Provisions security, alarm profiles,
MS-SPRings and overhead circuits.

Maintenance

Displays the type of equipment and the status Software
of each node in the network; displays working
and protect software versions; and allows
software to be downloaded.

Security, Alarm Profiles,
MS-SPRing, Overhead Circuits,
Provisionable Patchcords (PPC)

8.5.2.3 DCC Links
The lines show DCC connections between the nodes. DCC connections can be green (active) or gray
(fail). The lines can also be solid (circuits can be routed through this link) or dashed (circuits cannot be
routed through this link).
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There are four possible combinations for the appearance of DCCs: green/solid, green/dashed, gray/solid,
or gray/dashed. DCC appearance corresponds to the following states: active/routable,
active/nonroutable, failed/routable, or failed/nonroutable. Circuit provisioning uses active/routable
links.

8.5.2.4 Link Consolidation
CTC provides the ability to consolidate the DCC, general communications channel (GCC), optical
transport section (OTS), provisionable patchcord (PPC), and server trail links shown in the network view
into a more streamlined view. Link consolidation allows you to condense multiple inter-nodal links into
a singular link. The link consolidation sorts links by class, meaning that all DCC links are consolidated
together, for example.You can access individual links within consolidated links using the right-click
shortcut menu.
Each link has an associated icon (Table 8-12).
Table 8-12

Icon

Link Icons

Description
DCC icon

GCC icon

OTS icon

PPC icon

Server Trail icon

Note

Link consolidation is only available on non-detailed maps. Non-detailed maps display nodes in icon
form instead of detailed form, meaning the nodes appear as rectangles with ports on the sides. Refer to
the Cisco ONS 15454 SDH Procedure Guide for more information about consolidated links.

8.5.3 Card View
Card view provides information about individual ONS 15454 SDH cards (Figure 8-7). Use this window
to perform card-specific maintenance and provisioning. A graphic showing the ports on the card is
shown in the graphic area. The status area displays the node name, slot, number of alarms, card type,
equipment type, and the card status (active or standby), card state if the card is present, or port state
(Table 8-6 on page 8-9). The information that appears and the actions you can perform depend on the
card. For more information about card service states, see Appendix B, “Administrative and Service
States.”
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Figure 8-7

Note

CTC Card View

CTC provides a card view for all ONS 15454 SDH cards except the TCC2, TCC2P, XC10G,
XC-VXL-10G, XC-VXL-2.5G, XC-VXC-2.5G, and SC-VSC-10G cards. Provisioning for these
common control cards occurs at the node view; therefore, no card view is necessary.
Use the card view tabs and subtabs, shown in Table 8-13, to provision and manage the ONS 15454 SDH.
The subtabs, fields, and information shown under each tab depend on the card type selected. The
Performance tab is not available for the AIC-I card.
Table 8-13

Card View Tabs and Subtabs

Tab

Description

Alarms

Lists current alarms (CR, MJ, MN) for the card —
and updates them in real time.

Conditions

Displays a list of standing conditions on the
card.

—

History

Provides a history of card alarms including
date, object, port, and severity of each alarm.

Session (displays alarms and events
for the current session), Card
(displays alarms and events retrieved
from a fixed-size log on the card)

Subtabs
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Table 8-13

Card View Tabs and Subtabs (continued)

Tab

Description

Subtabs

Circuits

Creates, deletes, edits, and searches for
circuits.

Circuits

Provisioning

Provisions an ONS 15454 SDH card.

DS-N and STM cards: Line, Line
Thresholds (different threshold
options are available for electrical
and optical cards), Elect Path
Thresholds, SDH Thresholds, VC4,
and Alarm Profiles
Ethernet cards (subtabs depend on
the card type): Line, Line
Thresholds, Electrical Path
Thresholds, SDH Thresholds, Port,
RMON Thresholds, VLAN, Card,
Alarm Profiles

Maintenance

Performs maintenance tasks for the card.

Loopback, Info, Protection, and Path
Trace (options depend on the card
type)

Performance

Performs performance monitoring for the card. DS-N and STM cards: no subtabs
Ethernet cards: Statistics,
Utilization, History

Inventory

Displays an Inventory screen of the ports (TXP —
and MXP cards only).

8.5.4 Print or Export CTC Data
You can use the File > Print or File > Export options to print or export CTC provisioning information
for record keeping or troubleshooting. The functions can be performed in card, node, or network views.
The File > Print function sends the data to a local or network printer. File > Export exports the data to a
file where it can be imported into other computer applications, such as spreadsheets and database
management programs.
Whether you choose to print or export data, you can choose from the following options:
•

Entire frame—Prints or exports the entire CTC window including the graphical view of the card,
node, or network. This option is available for all windows.

•

Tabbed view—Prints or exports the lower half of the CTC window containing tabs and data. The
printout includes the selected tab (on top) and the data shown in the tab window. For example, if you
print the History window tabbed view, you print only history items appearing in the window. This
option is available for all windows.

•

Table Contents—Prints CTC data in table format without graphical representations of shelves,
cards, or tabs. This option does not apply to all windows. For details, refer to the print or report tasks
in the Cisco ONS 15454 Procedure Guide.
The Table Contents option prints all the data contained in a table with the same column headings.
For example, if you print the History window Table Contents view, you print all data included in the
table whether or not items appear in the window.
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8.6 TCC2/TCC2P Card Reset
You can reset the ONS 15454 SDH TCC2/TCC2P card by using CTC (a soft reset) or by physically
reseating a TCC2/TCC2P card (a hard reset). A soft reset reboots the TCC2/TCC2P card and reloads the
operating system and the application software. Additionally, a hard reset temporarily removes power
from the TCC2/TCC2P card and clears all buffer memory.
You can apply a soft reset from CTC to either an active or standby TCC2/TCC2P card without affecting
traffic. If you need to perform a hard reset on an active TCC2/TCC2P card, put the TCC2/TCC2P card
into standby mode first by performing a soft reset.

Note

When a CTC reset is performed on an active TCC2/TCC2P card, the AIC-I card goes through an
initialization process and also resets because the AIC-I card is controlled by the active TCC2/TCC2P.

Note

To avoid a node IP and secure IP ending up in the same domain after restoring a database, ensure that
the node IP stored in the database differs in domain from that of the node in repeater mode. Also, after
restoring a database, ensure that the node IP and secure IP differ in domain.

8.7 TCC2/TCC2P Card Database
When dual TCC2/TCC2P cards are installed in the ONS 15454 SDH, each TCC2/TCC2P card hosts a
separate database; therefore, the protect card’s database is available if the database on the working
TCC2/TCC2P fails. You can also store a backup version of the database on the workstation running CTC.
This operation should be part of a regular ONS 15454 SDH maintenance program at approximately
weekly intervals, and should also be completed when preparing an ONS 15454 SDH for a pending
natural disaster, such as a flood or fire.

Note

The following parameters are not backed up and restored: node name, IP address, mask and gateway, and
Internet Inter-ORB Protocol (IIOP) port. If you change the node name and then restore a backed up
database with a different node name, the circuits map to the new node name. Cisco recommends keeping
a record of the old and new node names.

8.8 Software Revert
When you click the Activate button after a software upgrade, the TCC2/TCC2P copies the current
working database and saves it in a reserved location in the TCC2/TCC2P flash memory. If you later need
to revert to the original working software load from the protect software load, the saved database installs
automatically. You do not need to restore the database manually or recreate circuits.

Note

The TCC2/TCC2P card does not carry any software earlier than Software R4.0. You will not be able to
revert to a software release earlier than Software R4.0 with TCC2/TCC2P cards installed.
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8.8 8.8 Software Revert

The revert feature is useful if a maintenance window closes while you are upgrading CTC software. You
can revert to the protect software load without losing traffic. When the next maintenance window opens,
complete the upgrade and activate the new software load.
Circuits created and provisioning done after a software load is activated (upgraded to a higher software
release) will be lost with a revert. The database configuration at the time of activation is reinstated after
a revert. This does not apply to maintenance reverts (for example, 4.6.2 to 4.6.1), because maintenance
releases use the same database.
To perform a supported (non-service-affecting) revert from Software R7.0, the release you want to revert
to must have been working at the time you first activated Software R7.0 on that node. Because a
supported revert automatically restores the node configuration at the time of the previous activation, any
configuration changes made after activation will be lost when you revert the software. Downloading
Release 7.0 a second time after you have activated a new load ensures that no actual revert to a previous
load can take place (the TCC2/TCC2P will reset, but will not be traffic affecting and will not change
your database).
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